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Preparing Your SE Program to Write Actual Orders 
Switching from Demo Mode to LIVE 
Before doing any setup and configuration work it is absolutely essential to switch from the DEMO to 
the LIVE Program if you haven’t already done so. 

To Switch from Demo to LIVE view: 

1. At the front screen, choose Configurations/Toggle 
Demo Mode. 

A Message Box confirms that you want to switch from 
Demo To Live program. 

 
2. Confirm that you want to run the Live Program by 
clicking Yes. 

Important Note: Make ABSOLUTELY sure you are in 
LIVE Program View before entering any shop data or 
settings. Otherwise, anything entered in DEMO mode will 
have to be re-entered in the LIVE Program Version. 

Configuring the LIVE SE Program for Your Shop 
It’s time to start customizing the LIVE version of SE software to match your business using this 
workbook. You’ll save a lot of time later and also improve accuracy by completing as much setup 
detail as possible now. 

NOTE This book is intended to help new users prep the LIVE version of SE to write live invoices. It’s 
arranged by Basic Setup (assisted by independent sales contractors) to get shop’s SE launched 
successfully. This is followed by Additional Setup options that we strongly recommend users then 
complete as soon as possible. Users may not use all of Additional Setup items provided. 

Review Program Setup Options 
Basics (Assisted): 

Default Settings, Labor Rate, Tax Rate, Shop Supplies, HazMat, Accounts, Payment Types, Markup, 
Technicians, Reports/Printers, Disclaimers 

Additional (User Self-Instruction): 

Category, Location, Status, Followup, Packages, Symptoms, Notes, End-Of-Day Reports, Validations, 
Screenview options, Program Security, etc. 

BONUS: SE LIVE Checklist 

This checklist helps you to be sure you’re ready to go live. By now setup is completed for a 
successful launch. Set your Starting Invoice and begin! 
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Tips for a Better Startup Experience 
• Consider ALL Program Settings Very Carefully Now. 

Many settings require a decision, configuration or data entry BEFORE using SE LIVE to write your 
orders. You’ll be very glad later you did. 

• Don’t Rush Yourself! 

The more prep work you get completed now, will improve your comfort level and speed, making your 
LIVE SE experience better right away. Database Backup and Validation 

Backup: It is CRUCIAL to keep up-to-date copies of your SE database just in case something goes 
wrong and it becomes necessary to restore it. There is an internal backup function (to USB flash 
drives) in the management program and we have also added a MSEC remote backup service as 
explained below. 

Your Database Backup Strategy 
Database Backup and Validation is a selection under 
Special Maintenance from the Configurations menu 

Database Validations are a quick check against the 
physical consistency of the database and ensures the 
ability to stay synchronized with SE Connection (or 
MSEC) for server-side backups and other features. The 
Weekly Validation is much more thorough and will 
catch items that wouldn’t normally be found without a 
thorough review by technical support agent. 

This is good for SE shop management systems users as 
the physical “check-in” will alert them to a potential 
problem, hopefully prior to any permanent data loss. If 
a problem is found, a message for the user to call 
technical support would be displayed on the screen. 
This situation would not prevent users from working in 
Manager SE; however, we’d still suggest contacting 
technical support at the first opportunity. 

 

NOTE: We still recommend shops continue using local backups to external flash drives to provide 
your shop with an extra measure of protection. 
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SE Setup Information Gathering Checklist  
This document is intended to inform new users of the extent of shop information required to gather in 
preparing the SE software to write actual invoices that match your business specifics. You should have 
received a copy of the checklist with your information packet. Once you’ve had a chance to review what is 
required, you can decide whether to input the details into this document or enter it directly into the SE 
Setup or Configuration screens, using the document as a checklist. 

We recommend that you fill out the checklist before completing this workbook to make more efficient use 
of your setup time investment. For your convenience, the two documents are cross- referenced where 
practical. 

Learn more with 100+ SE Training Videos!  
Manager SE comes equipped with more than 100 training videos covering virtually every 
aspect of the management software. Click the Training Videos link on the menu bar and 
then “How do I…” to access the Training Video master list.  

Note: Within this guide, when you see the training video icon, you can go directly to the relevant video by 
clicking on the Training Video icon for that section. 

Context-sensitive Training Videos can also be accessed via the online help system. Simply click F1 in any 
screen to access help specific to that screen. Most major screens and dialog boxes also have Training 

Videos specific to the area you are working in. 
Click the Training Video icon to run the video. 

 

 

 

https://managerhelp.buymitchell1.net/Howdoi.htm
https://managerhelp.buymitchell1.net/Howdoi.htm
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• Setup-Assisted Basics 
Create a User (Profile)  

To store and recall your WIP and Order screen layout preferences, 
create at least one User profile. This is accomplished through the 
Configurations > Program Security menu option. 

Enter user names with passwords to create User profiles. You may also 
enter job functions or filtered (EST only, etc.) screen views to meet 
your needs. 

NOTE: Program Security is discussed at greater length in the 
Additional Self-Setup section. Visit 
https://managerhelp.buymitchell1.net/Programsecurity.htm for a 
detailed description of Program Security and video links to Program 
Security setup and a Demo of how program security works. 

In Program Security Setup, click on Add to enter a name & password 
to create a profile. Do this for each user as required.  

 
  

https://managerhelp.buymitchell1.net/Programsecurity.htm
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Choose the User 
Click on Users icon and select User Preferences.  This opens the User Selection List. Click on 
the User you wish to use the preferences for and click OK. 

 
 

The WIP Grid and Order Screen Preferences of the selected user will be reflected in your screen 
display. 

User selection is confirmed by the display of the User name in the 
lower right-hand corner of the program screen.     

See https://managerhelp.buymitchell1.net/wipgridsettings.htm for details about WIP and Order 
Screen layout preferences. 

Presentation Settings 
The Presentation Settings control order display 
options and printing defaults. Most importantly, this 
is where you specify whether to display orders in 
Job View vs. Legacy View. Presentation Settings are opened by 
choosing Shop Data Setup from Configurations menu and then clicking 

on the Presentation tab. 

 

https://managerhelp.buymitchell1.net/wipgridsettings.htm
https://youtu.be/7C-zOMbeLik
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Group by Job View: 
• Group by Job View - When the Group by Job View checkbox is 

selected, repair work details are segmented into a rich by-the-job 
viewing experience on Order, Revision and History screens (click the 
video icon to the right for full details). This setting will also select the 
appropriate Job View Estimate & Invoice document templates that will display repair work in this 
same fashion. Unchecking this box restores the setting for the legacy view. 

Note: Group by Job View is a GLOBAL setting (all users). The default setting for new SE Customers 
is ON. You may deselect the setting to restore the legacy view, if desired. 

Additional Print and Display options: 

Note: Make sure that these options conform to your shop policy 
and State and Local Regulations. 

• Display Sublet as Labor - This option sets the default 
setting for the Display as Labor checkbox. Un-checking that 
box at the Sublet level reverts that Sublet to display/print as 
a 'Sublet.' 

• Display Order Level Charges - Generates 'Order' box on 
customer documents to display fees and order discounts, as 
applicable. 

• Set Category from Job - Copies Job Category to any 
container items lacking category information. 

• Show Labor Hours on Estimates/Invoices - Choose whether to display labor hours on screen 
display and printouts of Estimates and Invoices by default. Note: this can be overwritten in print 
preview window. 

• Show Part Numbers on Estimates/Invoices - Choose whether to display part numbers on 
Estimates and Invoices, by default. Note: this can be overwritten in print preview window. 

• Show Order Revisions on Invoices - Choose if you want to include Order Revisions on display 
and printouts of Invoices, by default. Note: this can be overwritten in print preview window. 

• Show Technicians on Invoices - Choose if you want to include the name of the Technician(s) 
on printed invoices. Note: this can be overwritten in print preview window. 

• Print Mode of Estimates/Invoices - Choose whether you'd like to print in Color or Black and 
White by default. 

 

 

https://youtu.be/W2EjXi-rcxo
https://youtu.be/W2EjXi-rcxo
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Shop Data 1 & 2  
Enter your Shop Data specifics [recorded in the Information Gathering 
Checklist] into these screens; this data appears on all printed output (EST / 
RO / INV, reports, etc.) NOTE: Account # is automatically filled from Help - 
Activate Products. 

 

 

https://youtu.be/L3zIxk2K1kk
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Default Settings 
Enter your own Default Settings preferences (recorded back on page vii) into the 
screen shown below. Default Settings allow you to automate settings / values to 
be applied. You’ll build faster, more accurate orders, as this default information is 
automatically entered for you. 

NOTE: We recommend using ‘Please Select’ as default Labor Technician, as this provides a labor cost for 
F12 Profit Wizard calculations. See Tech Setup. 

 

 
 

You MUST backup your management program on a daily basis. 
The overview of how to setup local protection of your data is shown back on page ‘vi’. Please also review 
the training video for full setup of database backup under Training Videos -> How Do I?- 
> Database Backup and Validations. 

 

 

https://youtu.be/X81cUJ6l5x4
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 Shop/Hazmat  
With Defaults set to ‘ON’, Shop Supplies and/or Hazmat (hazardous materials) can 
be automatically calculated by labor or parts order totals (or use both) and added to 
estimates and repair orders. 

 
 

NOTE: Behavior option is provided for instances where the HazMat is to be taxed differently from Labor. 
This also determines where HazMat is displayed in document totals. 

Note: While these are defaults to use for all orders, they can be removed (from specific order only) by 
unchecking the boxes found in Order Options. 

 

NOTICE: States may require itemized shop supplies; if so, set Shop Supplies Default to 
Off; create a parts kit of shop supply items to recover costs and satisfy legal 
requirements. 

 

https://youtu.be/Gl_K2CRo9sw
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 Disclaimers  
Disclaimers provide placeholders for your “business language” on Estimates, 
Repair Orders, Invoices and Counter Sales. These will appear at the bottom of 
printed documents. SE comes with “generic” standard disclaimers; customize 
these or rewrite them entirely. For Spell Check, press the F2 key. Below is a 
sample; you’ll want to write your disclaimer to reflect your business policies: 

Important NOTE: Make sure all of your disclaimers are written in accordance with local, state and federal 
regulations. In some instances, it may also be necessary to use specific Estimate or Invoice templates to 
fully comply with state and local requirements. These template options will be listed in Configurations –> 
Reports/Printers –> Select Report drop-down list. 

 
The Estimate disclaimer text is displayed first. Edit the Estimate disclaimer text as needed. Repeat for 
each of the rest of the order states: Repair, Invoice, and Counter Sale by toggling the radio buttons. 

 
 

https://youtu.be/IiXag6-qgVE
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Labor Rates 
Labor table stores up to 10 different shop labor rates. Customers can be assigned (using Customer Type) 
to any of these labor rates as default for their estimates & orders 

NOTE: Labor rate can also be assigned per vehicle as well, should the need arise. 

 

NOTE: Line 1 is DEFAULT LABOR RATE (automatic) and will be applied unless another rate is selected. 

Price Levels 
Price Levels table allows storage of up to 10 levels of parts pricing. Parts entered 
on an estimate or RO reflect any price level defined (selected by Customer Type). 
Prices for any or all parts can also be changed (exceptions) at the order item level. 

 

Important! Keep Line #1 at 0% or you’d automatically discount every part sold! Negatives values (ex. - 
10%) will instead add percentage to parts prices. 

https://youtu.be/3f4pi1TFS6I
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 Tax Rate 
Tax Rate Table supports up to seven different tax rates. Most shops have only one. 
Line 1 should have ‘X’ in Default. (Most shops can enter a single tax rate) 

Note 1: Line #1 default value is a global tax setting SE will apply. Tax exceptions (selecting alternate rates 
listed here) can be made at Customer, Vehicle, Order or even the Order Item line levels. 

 
Note 2: The Shop Management System ships with Tax flag on. Tax is set to 0% until your tax is 
entered. Customers can be set to be non-taxable during entry. 

Note 3: The NEW Tax Calculation Method selector should be set to Standard. Other calculations options 
are not in play at this time. (alternate Florida tax method was rescinded)   

   

https://youtu.be/GQ_10VLvpBI


10 
 

Compound Taxes 
Compound Taxes Table allows you to set up compound or excise taxes if you are required to do so. 

 

 

NOTE: In most shops, only the standard Tax Rate Table (above) is used; this 
provision is included for special situations that may. Please watch the Training 
Video if you have questions about Compound Taxes. 

  

https://youtu.be/GQ_10VLvpBI
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Income / Payment Types  
Income Accounts are General Ledger (GL) account #s where revenues are 
grouped for accounting purposes. Finalize before going LIVE. 

Payment Types - This is where you add a credit card, debit card, or any new 
payment type for inclusion in the drop-down list. 

Important: Think very carefully about your payment types/accounts before you start creating live orders! 
Once a payment type has been used, it CANNOT be deleted. 

 

Note 1: Payment is funds 
received as cash, credit card, 
check, etc. These are reflected 
on Accounting Reports. 

Note 2: This is where you 
would click Add to enter any 
Electronic Payment types –
such as Debit Cards or 
additional credit cards. 

Note 3: To set a single default 
payment type – go to Setup > 
Shop Data > Default Settings 
and enter that’s in Default 
Payment Types field. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  

https://youtu.be/38VicVXh6TI
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Standard Accounts 
Standard Accounts is where you enter general ledger codes for Accounts 
Receivable, Customer Deposits, and Retained Earnings. 

NOTE: Most shops will use the default GL Codes; you should too, unless your accountant wants to change 
any of these. It is recommended to discuss and confirm BEFORE you begin your live invoicing. 

 
 

  

https://youtu.be/muLtJYkgbGk
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Account Classes 
The Account Classes area allows the selection of the specific accounts that each 
type of revenue from shop invoices will flow into and accumulate for accurate 
reporting. 

NOTE: In most shops, account class assignments typically match descriptions seen on the left-hand side, 
one-for-one. This screen supplies some latitude in case shops need some flexibility. Confirm all these 
account assignments BEFORE going live. Changes made later will impact your reporting accuracy. 

 
 

  

https://youtu.be/38VicVXh6TI
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 Markup   
In Markup, you can enter your shop’s Markup percentage. In the example, 
Sublet items will be marked up 25% (which in turn, provides a 20% profit). 

You can also markup OE Parts and Labor time transferred from Estimator. An 
OEM part with a list price of $100 would transfer into an estimate as $110 (@10% Markup). Labor hours 
(@10% Markup) would transfer 1.0 hr. as 1.1 hrs. 

 

NOTE: Shop Overhead % + Misc. Overhead % DO NOT affect prices on estimates and repair orders. These 
are used internally to give the Profit Wizard realistic numbers to reflect true cost of doing business. 

 

Business Tip: Be sure to review the Markup Percentage vs. Gross Profit discussion on the following 
pages for a story contrasting these two very different approaches. 

 

https://youtu.be/QVLwNWstz4A
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Markup Percentage vs. Gross Profit Examples 
Example 1: Markup Part by Percentage 

• Joe the owner buys an alternator for $100 and wants to “mark it up” 40%. 

• Joe’s selling price for the alternator is now “marked up” to $140. 

• Joe is convinced that this 40% Markup is “fair” to his customers. 

Part Cost Markup Percentage Retail Selling Price 
$100 40% $140 

Example 2: Discounting “Marked Up” Parts 

• Joe’s best customer Bill needs to buy that same $140 alternator. Bill gets a 30% discount 
on his parts. (hefty discount with company fleet business) 

• Joe discounts the $140 retail-selling price by 30% and takes off $42. 

• Joe doesn’t realize that he is selling the part ($100 cost) for $98 ($2 less than what he 
paid). Instead of still making 10% on the part, he lost 2%. 

Retail Selling Price Bill’s Discoun  Joe’s Discount Price 
$140 30% (-$42) $98($2 net loss) 

Rhetorical Question: Is this perhaps why Joe has such a hard time turning a profit? 

Example 3: Using Gross Profit to Determine Retail Selling Price 

• Joe, the shop owner/service writer, wants to make a 40% gross profit on every part he 
sells. 

• To do this, Joe must add 66% to his cost on the alternator and sets the retail-selling 
price at $166. 

Part Cost % Added to C  Retail Price Gross Pro  
$100 66% $166 40% 

Example 4: Discounting After Using Proper Gross Profit 

• Ben comes into the shop and needs to buy that same alternator. Loyal customer Ben gets 
a 30% discount on his parts. 

• Joe discounts the $166 selling price by 30% and takes $49.80 off the retail-selling price. 

• Joe’s not making much money this time, but at least he isn’t losing any money selling the 
alternator to Ben at a 30% discount. 

Retail Selling Price Discount % Discounted Price 
$166 30% (-$49.80  $116.20 
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 Parts Markup & Gross Profit Projections Table  
Markup is the percentage of the amount you earn on the cost of an item 
purchased. Gross Profit is the percentage of the amount you earn on the 
selling price of the item. Gross profit tells you what you retain on each sale. 

 
% Added to Cos    Gross Profit 

Part Sale 

30% 23.1% 

31% 23.7% 

32% 24.2% 

33% 24.8% 

34% 25.4% 

35% 25.9% 

36% 26.5% 

37% 27.1% 

38% 27.5% 

39% 28.1% 

40% 28.6% 

41% 29.1% 

42% 29.6% 

43% 30.1% 

44% 30.6% 

45% 31.0% 

46% 31.5% 

47% 32.0% 

48% 32.4% 

49% 32.9% 

 

% Added to Cos    Gross Profit 
Part Sale 

50% 33.3% 

51% 33.8% 

52% 34.2% 

53% 34.6% 

54% 35.1% 

55% 35.5% 

56% 35.9% 

57% 36.3% 

58% 36.7% 

59% 37.1% 

60% 37.5% 

61% 37.9% 

62% 38.2% 

63% 38.6% 

64% 39% 

65% 39.4% 

66% 39.8% 

67% 40.1% 

68% 40.5% 

69% 40.8% 

 

% Added to Cos    Gross Profit 
Part Sale 

70% 41.2% 

75% 42.9% 

80% 44.4% 

85% 45.9% 

90% 47.4% 

95% 48.7% 

100% 50% 

125% 55.6% 

150% 60% 

175% 63.6% 

200% 66.6% 

225% 69.2% 

250% 71.4% 

275% 73.3% 

300% 75% 

325% 76.5% 

350% 77.8% 

375% 78.9% 

400% 80% 

500% 83.3% 
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 Price Markup Matrix  
Price Matrix supports up to 10 levels of markup according to cost $ range: 

 

NOTE: Last Cost / Average Cost is a GLOBAL decision impacting ALL part sales profitability reporting. 

 Parts Pricing 
We strongly recommend the Price option so that the Price Markup Matrix can 
calculate your selling prices.  

 

https://youtu.be/aHcW28BcSLI
https://youtu.be/Ifx_r38bxZY
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 Scheduler Options 
Schedule options are found under Configuration/Scheduler Setup/ Schedule 
Options. These options include defining regular business hours, the range of 
hours to be shown in the calendar, number of previous days displayed by default, 
and selecting any recurring holidays or special events. 

 

 

Opening Schedule starts in – Select default opening view when Scheduler is opened. Users 
can choose Scheduler, Appointment and Shop Event Tabs; others are reserved for future use.  

Regular Business Hours 

Each day of the week must be setup as either CLOSED or with 
Start / End times. To set the start time for Monday, left-click on 
the Monday button, doing so will set the initial Start and end 
Times as 8:00 AM to 5:00 PM and paint the button green. Set the 
time for each day of the week, then if required modify the times 
for each day by clicking on the down arrows.  

 

Hours Visible on Schedule 

Visible Hours - Sets system display for the part of the day you 
want to see in the calendar view. Typically, this would be set to an 
hour before and after your regular business hours. 

Show Last (number of days) - This controls the range to display 
in the calendar previous to the current date. Experiment with this 
setting to meet your specific needs. 

  

https://youtu.be/Xo1k7RKtb7I
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Auto Adjust Appointment Time - This default setting 
is provided to save user time and effort if actual Order 
Hours increase, due to additional work being sold. The 
appointment time will automatically be extended in the 
Scheduler to reflect this change. While this can be 
turned off at the individual appointment level, it’s 
probably a good idea to leave it turned on. 

Drop Off Time - Set a default Drop Off time to have 
this automatically filled in, saving time as you create a 
new appointment in the Scheduler. Select the most popular drop off time and enter it here. It can always 
be updated at the individual appointment level. 

Match Drop-Off to Start Time: Check this box to automatically match the Drop-Off time to the Order 
Start Time if you prefer a simpler approach. 

Browser Map Provider: Choose between available browser maps (Google or Bing). 

Scheduler Refresh Interval – The update frequency of 
Scheduler related columns on WIP screen is defaulted to 30 
seconds; this can be slowed to every 5 minutes, if the refresh is 
distracting. Set a longer time on PCs where appointments are not 
made. Changes to Scheduler items will simply not appear in the 
WIP screen data as quickly. 

 

Holiday Setup 
Click the Holiday button to set up days that the shop is closed for business. 

 

Name and Occurrence type, date and Occurrence define holidays. The Import button presents you with a 
list of standard US Holidays to be auto-imported into the yearly calendar. Simply choose the holidays from 
the list to enter it into your Holiday list. 

To enter an additional Holiday or special event not listed, click on Add button, then Name the holiday or 
event by typing text into the Name field. 

Holiday Occurrence Type defaults to today’s date; you may overtype this or use the calendar tool to 
enter a specific date. If this is a recurring event, change to Pattern mode and enter parameters such as 
‘Fourth Wednesday of October’ for example. Be sure to click Save for any holidays created and then click 
the Red X to close the Holiday Setup window when finished. 



20 
 

Scheduler States 

Configurations > Scheduler Setup > Add/Edit Schedule States 

Appointment states are used to represent the current state of the appointment. 
Several common appointment states are provided as system defaults; these cannot 
be changed. These include Waiting, Arrived, Awaiting Parts, Call and Remind, Call Customer, Cancelled, 
Closed, Finished, No Show and Open. 

 
Status Map – Provides the ability to map Appointment States to Order Statuses. With 
relationships in place, any changes to Appointments will automatically change the WIP 
screen order Status entries or vice-versa. This saves time and prevents errors. 

 

Tip: Mapping Repair Order Statuses and Appointment States improves efficiency and accuracy and 
eliminates conflicting information from manually trying to keep two program areas in agreement. 

https://www.youtube.com/watch?v=JwWQgkxC_ZA
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Schedule Resources 

Configurations > Scheduler Setup > Add/Edit Schedule Resources 

Schedule Resources allows you to catalog your bays, pieces of equipment, scan tools, lifts, tire 
machines, locations or anything specifically required for certain types of appointments. Each 
resource is defined by Name, Schedule Color (easier to identify on the calendar), Brand Name, 
Nickname, Size, Serial Number, Location, Description, Warranty Information, and Notes. 

Add/Edit Schedule Resources 

Catalog a new resource by clicking on the Add button and complete any or all fields. The Active in 
Scheduler checkbox controls visibility of the resource for potential assignment; it is checked by default. 
Remember to click on Save when finished. 

NOTE: At this time, only one resource may be associated with an appointment or shop event. 

 

https://youtu.be/B1OR-dUxIrE
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 Technicians Setup  
Technicians Setup is selected from the Configurations menu. 

There are three areas to fill out in Technicians setup: Wages and Commissions, 
Hours, and Address. This is used to create data for Tech Commissions Report 
and figuring shop’s profit margin on work performed (F12 Check Profit function).  

NOTE: If a service writer sometimes also performs labor, they would be set up 
twice; once as a Service Writer and also as a Technician. This ensures the 
name(s) appear in both the Labor Technician and Service Writer drop lists. 

 
Click on Add to create a new tech or Edit to edit an existing tech. This opens the Employees dialog box.  

Wages & Commissions  

 

https://youtu.be/xhCNehRnvRM
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Input: Space is provided in SE Setup Information Gathering pages to record multiple Technician(s) & 
Service Writer(s) details; fill in the data or enter it directly into this SE program technician screen. 

Hours of Availability 

Click in each cell to enter the appropriate Start and End times. If this person is not available on certain 
days, you may highlight the times in cells and press Delete to make those cells blank. 

 

  
 

Employee Address 

Enter any appropriate details in the fields provided.  
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 Reports/Printers 
Reports/Printers allow users to decide what style of 
printout is generated, which printer(s) are used, how 
many copies are printed. Microsoft Windows selects default printer 
automatically; different printers (or printer trays) may be selected for the various 
types of documents. Reports/Printers/Lube Sticker is a selection from the 
Configurations menu. 

NOTE: When users click on the Print button, the program immediately prints 
the number of copies specified for the selected document (2 copies for Invoice, 
etc.) If you wish to preview the document before actual printing, you should 
select File > Preview. 

Estimates, Repair Order, Invoice, Counter Sales 
Select the Report template and Printer device to complete each of your selections. Default Report 
templates are provided for each order status, pick a different Report type if desired. 

 
Repeat for Repair Orders, Invoices, Counter Sales, Technician Worksheet, Labels. The process is essentially 
the same with the following exceptions/considerations. 

• Estimates - Typically two Estimate copies are printed; one for customer and one for shop to file. 
Choose Email Template Editor if you desire to modify the standard email template for Estimates. 

• Repair Orders - It is possible to ‘Mark all ROs as Approved/Printed’ under Screen View tab options, 
if you don’t need to actually print ROs. Choose Email Template Editor if you desire to modify the 
standard email template for repair Orders. 

• Invoices - It is recommended that two Invoice copies are printed; one copy for the customer, 
another copy for the shop to keep on file. Choose Email Template Editor if you desire to modify 
the standard email template for Invoices. 

• Labels - Make certain you select the ‘with’ or ‘w/o vehicle’ option that best fits your label & 
postcard printing needs. 

NOTE 1: Special EST / RO / INV templates are provided to meet specific requirements by certain states. 
These will include a state abbreviation in the titles in the list. Your SE Setup Information Gathering 
document also indicates where any state-specific template options available. 

NOTE 2: Group By Job View - appropriate document templates (by state) are automatically selected. 

https://youtu.be/bNNMYiXbyxA
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Lube Sticker Printer 
Setup for Lube Sticker printing is more complex than for other reports, essentially a five (5) step process. 

 
1. Click the Lube Sticker Printer option. 

2. Set your Print Options to match the Printer, Paper Size, Orientation, and Template you require. 

Note: You must first set up your sticker printer and make it visible on your network for it to appear on the 
Printer list. 

3. Set your Default Settings. These are the settings that will display when launching the Print LOF option 
from the Order tab. 

Note: The LOF/Category Names are the same ones used in your LOF packages. 

4. Setup your Print Margins, Tagline, and Logo 

• Print Margins - manually adjust margins. Settings will automatically adjust to fit best based on the 
selected paper size. 

• Select Logo - browse and select logo image file. Maximum file size is 98 KB. 

5. Print Preview/Print Sample 

• Changes to the sticker template will display in real-time in the Print Preview section. 

• Click Print Sample to print a sample of how your sticker will look. Adjust your print margins as 
needed to ensure proper alignment. 
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Email Template Editor 
By default, Manager SE includes generic messages that include basic customer and shop information. This 
is included in the ‘handoff’ to your shop PC’s email client (Outlook, Thunderbird, etc.) to customer’ email 
Inboxes. Click on the Email Template Editor button to open the editor to change an email template for the 
selected document type. Make note of your selection before clicking the button so that you can see and 
edit the appropriate message content. ‘Estimate’ is selected by default so we’ll take a look at that template. 

This editor allows you to create their own preferred message to be included when emailing an Estimate, 
R.O. or Invoice to a customer. You may free-form type anything with basic tools or incorporate actual 
database fields into the Subject line and the message body itself. You only type what appears in black; any 
blue text shown in brackets is a database field that has been inserted. 

Click inside your template message (or template subject line) where you want to insert a database field, 
then select that field (listed in Report Template Parameters), then click the double-arrow to insert that spot 
in either the Template Subject or Template Body you specified. 

 
Click on Save in editor to keep template changes; then click OK in Report/Printer selection screen to close. 

A customized email template can include customer, vehicle, shop and repair specifics. See Report Template 
Parameters (database fields list) above for additional possibilities to include in your email template(s). 

 

Using the Email Templates Editor to tailor your outgoing email will ensure proper messaging, accuracy and 
personalization. Manager SE will even insert the amount due on your Invoice template, if you so choose. 
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 Screen View  
Screen View allows users to customize program preferences. 

Recommendations for various Screen View option settings are shown below, with 
further background provided for each on the following page. 

 
Screen View options Recommended 

Enforce Mileage In [can be password protected] Yes No 

Show Odometer Out [required in some states] Yes No 

Starting Cursor Position on Customer Screen Company Customer 

Display Customer OR Company Name in WIP Company Customer 

Display Margin in WIP [sensitive business data] Yes No 

Odometer Display Option Miles Kilometers 

Show License at Top of Vehicle Screen (not VIN) Yes No 

Show Quotes in Schedule Yes No 

Show Estimates in Schedule* [see next page] Yes No 

Show RO in Schedule* [see next page] Yes No 

Show Symptoms on New Orders [pops up list] Yes No 

One Start Toolbar (default is Yes) Yes No 

Mark All ROs As Approved/Printed Yes No 

Auto Scheduling Default Never / Prompt / Always 

https://youtu.be/Tg2DOmZy6yM


28 
 

Details for Screen View tab options 
• Enforce Mileage In: is provided to ensure that service advisors always enter mileage. 

This is crucial for accuracy with sending shop’s service reminders to customers. 

• Starting Cursor Position / Display Customer or Company: Unless your shop does a 
lot of commercial fleet business, select Customer instead of Company name as starting 
point for customer data entry /WIP display. 

• Show License at Top of Screen: Previously, most users preferred to start vehicle data 
entry with VIN decode. Since the introduction of Plate-2-VIN lookup, users prefer a 
Vehicle screen leading with license plate field. If you prefer starting from the VIN entry 
field, leaving this selection UNCHECKED will place the VIN field first, followed by license 
plate field. 

• Show Quotes in Schedule would very likely clutter your Schedule with items that have 
no commitment level or customer contact information. 

• Use Show Estimates in Schedule if you plan to schedule with them; otherwise uncheck 
the box to not clutter your Schedule with these items. 

• Show ROs in Schedule for most shops, this is the setting you will want to use for your 
Schedule display. If your system is set to launch as RO, skipping Estimate stage, you 
must select yes for them to become scheduled. 

• Show Symptoms on New Orders: is very useful because it pops up the Symptoms list 
so that users are reminded to use them. Press ESC to exit if the Symptoms list is not 
needed. 

• Mark All ROs as Approved/Printed: option eliminates the previous steps required to 
mark an RO as “printed” to put parts into ‘Committed’ status. 

• Auto Scheduling Default: When posting an invoice, SE can open the Schedule - 
Appointment Editor to arrange customer’s next appointment. Always will open the 
appointment editor with customer and vehicle already selected; Prompt will ask if you 
want to do that; Never setting will not open the editor or ask if you want to do so. 

Assisted Setup Complete! This concludes the basic setup task required for invoicing; please continue 
with self-setup options to complete additional configuration aspects. Remember F1 Help and SE training 
videos are available for these additional concepts. 
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•  Setup-Additional by User  

 End of Day Reports 
End-Of-Day Reports setup is where you select which reports will be run together 
as a “batch operation” at the close of business. This saves time at the end of 
every business day. 

Consider which reports you want to run on a daily basis and then open 
Configurations – End of Day Reports and use steps below to tag them. 

Select your reports by checking the box (or double-click on highlighted line). You 
may include any report that doesn’t require a secondary decision such as tech, 
vendor, etc. 

NOTE: Once using the LIVE program, you’ll start End of Day Reports process by 
clicking on Utilities menu and selecting the End of Day Reports option. 

 
  

  

http://youtu.be/me_k7b5mQKs
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Configuring Shop Reports 
Shop Reports provides the ability to view selected Manager SE reports remotely, wherever the internet 
and a browser are available. Access it by logging into ProDemand and selecting a new Shop Reports 
module added to the home screen.  

NOTE: This Feature is intended for shop owners and managers. 

Two videos are available: 

Shop Reports Configuration (4 min): https://youtu.be/eChKA0ydVmo 
Shop Reports Demo (2 min): https://youtu.be/f-hPPCJhmIM 

 

Notes 
Time-saving Notes can be attached to orders with just a click. Notes are used to 
transmit reminders and service messages to customers. It is also the place to build 
and store your list of repeated Recommendations. 

NOTE: Your SE program includes sample Notes to customize now and/or add new Note entries later. 

 

https://youtu.be/eChKA0ydVmo
https://youtu.be/f-hPPCJhmIM
http://youtu.be/WGT_dsgg_Tc
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 Estimate/RO & Invoice Validations 
When you print an estimate, repair order or an invoice, the software uses 
Validations to check for missing or conflicting information. You’ll see a warning 
and dialog box to enter that information and then proceed to printing. 

 

Estimate / RO Validations 

 

Invoice Validations 

NOTE: By default, ALL validations are enabled. We recommend leaving these on, unless you have a 
specific reason to bypass. If any appear, users are shown fields that require data. Enter it and press Enter 
key to continue. Group By Job View: Items missing techs or Category are highlighted on Order screen. 

 

http://youtu.be/TX7XAiTFcsE
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 Late Fees  
Late Fees option provides users with a method to automatically calculate late 
charges for customer accounts that are 30 days overdue. Read the important 
NOTICE below, place a check in Apply Late Fees to activate and begin setup. 

Tip: Be sure to watch the Late Fee training video to setup the Account Class Revenue for Late Fees to 
appear for selection here in the drop-down list. 

 

 

NOTICE: Before enabling, consult local and state regulations regarding late fees. Please be advised we will 
not responsible for ensuring your compliance with laws regarding the assessment of late fees or other 
interest charges on outstanding account balances. We will not be held accountable for misuse or failure to 
comply, nor be responsible for financial or legal implications. 

 

  

  

http://youtu.be/E-dNizXGhR8
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Category 
Category descriptions help to organize your parts & labor for faster access. 

Categories make reports meaningful and easier to read. Shops can use these to 
track which business categories are performing well or not. 

Add your own Category Descriptions (if any) directly into program. SE comes with a stock set of Category 
Descriptions, add your own as needed. 
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Part Code  
Part Codes are abbreviations to help you enter parts faster. 

When adding a new part to an estimate, by typing BAT into Part Code, the Description (Battery) fills 
automatically. Part Codes can also be set to fill in the related Category and even the Vendor information. 

  
The program comes pre-loaded with many Part Codes. Two reports are provided to display existing Part 
Codes with associated descriptions. 

NOTE: If using integrated parts catalogs to order parts, there is far less need to use Part Codes as the 
Description and Vendor data fields will be filled in automatically. 
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Phone  
Phone setup stores up to 10 different Phone Descriptions labels. These allow you to handle customers who 
may have multiple phone options. 

The program comes loaded with all the descriptions you are most likely to use. 

Double-click on any description to edit 

 

 

Warning! Do NOT change these entries once customer phone #s have been entered. If you wish to 
rearrange these entries, to put Cellular in 1st slot, for example, use the new drag and drop option. 

NOTE: If using the MessageCenter texting option, use Edit to set an entry for texting by selecting 
Mobile/Text from the Type menu. For further details refer to MessageCenter help topic: 
https://buymitchell1.net/managerhelp/TextSetup.htm 
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Title  
Title descriptions allow you to use standard salutations for customers. The program 
doesn’t require you to enter titles for your customers, this is purely optional. The 
program comes with a list of Title descriptions which work fine for most customers. 
You may add, edit or delete any of these Title descriptions as needed. 

 

NOTE: Default in customer entry is <none>; apply these as you like.  

 Location 
Location descriptions are used to keep track of where vehicles are located at 
your business. This can be important to a large shop with multiple parking areas. You may record up to 10 
locations to be stored entries. You can still free-form type any additional one-time entries as needed. Use 
the add/edit/delete options to customize for your shop. 

NOTE: Program comes with a list of sample Location descriptions. This will be an item on your ready-to-
go-live final checklist. 

 

http://youtu.be/YJuzNJV4ZzY
http://youtu.be/oFZAS1Z8qpU
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 Status 
Status allows you to maintain a common set of repair status descriptions. These 
are handy for the service writer or manager when customers call about their 
vehicle. 

You may record up to 10 locations to be stored entries. You can still free-form type any additional one-time 
entries as needed. Use the add/edit/delete options to customize for your shop. 

 

NOTE: The program comes with a list of sample Status descriptions. 

Click the Add/Edit button to open the Repair Order Status dialog box. You are able to customize the 
background color and/or text color for each Status entry using this dialog box. 

http://youtu.be/f42XFNyyJW8
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 Followup (Postcards, Letters, Mail-Merge)  
NOTE: Mail Merge function requires Microsoft Word. Refer to Knowledgebase 
articles for further details. 

Followup allows generation of 
Postcards and Letters, even Mail-
Merge letters so you can send out 
reminders, recommendations and 
announcements to customers. 

SE comes with sample Follow-up 
Postcards and Letters, with 
add/edit/delete options to tailor 
these to your business. 

NOTE: *MM – Create Data 
Export File option is provided to 
export SE data to use in 
spreadsheet programs such as MS 
Excel where the data can be 
sorted and filtered for shop 
marketing and sales analysis. This 
system entry is only visible under 
the actual Followup tab in 
Reports. 

 Vendor Type 
Vendor Type 
descriptions are 
used to identify 
the vendors 
supplying parts and services to your 
business. Vendor Types are general 
headings, not the specific vendors from 
whom you buy parts. 

You may add/edit/delete these as you 
wish. Please enter examples of your 
own Vendor Descriptions currently used 

at your place of business. 

 

 

http://youtu.be/bObQFazdXjo
http://youtu.be/b9hI22E4AFM
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 Symptoms  
Symptoms save shops many keystrokes when estimating a diagnosis. 

With Symptoms, you’re speaking the 
customer’s language, making it easier to 
receive a vehicle with standardized labor 
charges. Symptoms curb giving away of 
shop diagnostic time. 

NOTE: You may also add a new entry on-
the-fly using Save as standard Symptom 
checkbox in same window. 

 

 

TIP: Symptoms may be set to pop up 
automatically under Screen View tab. 

 

 

 

 Program Security  
Setup This program area allows the shop owner or 
manager to password protect sensitive information. For 
example, shops may not want techs knowing how much other techs are paid. 

Setup Program Security area allows the shop owner or manager to password 
protect access to sensitive information. For example, shops typically don’t 
want techs knowing how much other techs are paid or to browse reports. 

Program Security supports multiple passwords (rights assigned per user) to 
control who can delete orders, delete payments, change inventory, etc. 

NEW: Change Protected Areas now includes Main / Reports tabs. This allows 
shops to provide specific report(s) access per specific users.  

Demo Watch the SE Program Security Demo video to 
learn more about how passwords and protected areas 
define a security strategy for your shop. 

NOTE: If you enter or change master password, be sure to record it for 
later reference. 

 

 

 
 

https://youtu.be/Q_VujmvZ3r4
http://youtu.be/PX-OK5jzV00
https://youtu.be/7HXW5K-fHHo
https://youtu.be/Q_VujmvZ3r4
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Promotions: Packages & Discounts 
Packages are single line items sold by price. You may optionally add the 
parts & labor details later, but the customer only sees the single line on 
invoice that you created in these Packages. 

These are good for sales where inventory concern is not as critical. (You 
can add detail, however it’s time-consuming for each sale) 

Discounts apply a flat dollar amount or percentage discount to total parts 
and/or labor $ on an order as defined. For example, you might offer a 
10% labor discount to all AARP members. 

Packages and Discounts are applied via the Promotions button on Order 
screen. 

Go to Configurations -> Packages & Discounts; select Discounts 
or Packages tab. Then use Add/Edit to customize the entries. 
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 Promotions: Tire Packages  
Tire Packages are groupings of tires, related parts and labor operations to 
create varying service levels. 

To add or edit a Tire Package, select Tire Packages from Setup menu and 
then Add/Edit in Tire Packages Edit dialog box. 

SE comes equipped with sample packages for Tire Only, Tire and Mounting 
only, Platinum, Ultra Platinum, and Lifetime packages. You can edit these 
packages levels and add new packages as desired. 

NOTE: Tire Packages support the selection of either inventory items or parts 
catalog items. 

Tire Packages are applied to orders via Promos icon on Order screen. 

For a detailed description of setting up and applying Tire Packages go to Help 
-> Promotions -> Tire Packages [Shortcut: press F1 key] 

 

https://managerhelp.buymitchell1.net/PromoTires.htm
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 Promotions: Brake Packages  
Brake Packages are groupings of brake part and labor operations to create 
packages of varying levels to offer to your customers. 

To add or edit a Brake Package, select Brake Packages from Setup and then 
Add/Edit in Packages Setup dialog box. 

Manager SE comes equipped with sample Silver, Gold, and Platinum labels in 
combination with Front and Rear brakes. You can edit these packages as 
desired. 

NOTE: Brake Packages interaction with Inventory is limited to only items 
included in the package itself. 

Brake Packages are applied to orders via Promos icon on the 
Order screen. For a detailed description of setting up and 
applying Brake Packages go to 
Help -> Promotions -> Brake Packages [Shortcut: press F1 key] 
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 Promotions: Lube, Oil & Filter Packages  
Each LOF Package is a grouping of fluids, parts, and labor operations to form 
pre-built 

combinations to save input & selection time. 

To edit a LOF Package, select Lube, Oil & Filter Packages from Setup, pick a 
package and then Edit in Packages Setup dialog box. 

Program comes equipped with sample packages for various motor oils in 
combination with 4 & 5 qt. quantities and lube service. Edit these as desired. 

NOTE: LOF Packages interaction with Inventory is limited to only items 
included in package itself. 

LOF Packages are applied to orders via Promos icon on Order screen. 

For a detailed description of setting up and applying LOF Packages go to Help 
->Promotions -> LOF Packages [Shortcut: press F1 key] 
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 Manufacturers (Line Codes) 
The Manufacturers tab (Configurations > Standard 
Descriptions) displays Line Code data used with on-line 
parts ordering. Can also be used to filter part lookups on Inventory List. 

 

 

NOTE: The Manufacturers list is typically populated by electronic parts catalogs. Codes can be entered if 
your shop needs to order non-connected catalog items. 

 Zip Code Mapping 
Zip Code Mapping allows shops to override existing zip 
code database results to change City & State filled in 
when the Zip Code is entered. Click Done and the new 
results will be used instead, wherever that zip code is entered. 

 

http://youtu.be/pXSis-tC2G0
http://youtu.be/yzAdf-vvSf0
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 Tire Matrix 
Tire Matrix shares most features of the Price Markup Matrix; it’s dedicated to a 
tires category that a user creates. It also provides a method to configure one or 
two tire fees with a number of options to address all state regulations. 

Click the Tire Fees button to open the Tire Fees dialog box. This screen allows you to add up to two 
additional fees to the order. Once you have set up your matrix, click the Apply to Tires button to apply the 
matrix Price amount to all inventory and canned job tire records. 

 
 

http://youtu.be/x_sAlDJKzug
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 Vehicle Preference  
The Vehicle Preference dialog box allows truck information (CVG) 
subscribers to select which vehicle 
model list to display when selecting 
a vehicle.  

 

Note: This section is only applicable to Medium and Heavy Duty 
Truck users with a Manager SE CVG subscription.  

For users who work on Medium and HD Vehicles exclusively, checking the appropriate box ensures that your 
users are presented with Class 4-8 vehicles model list. 

If your shop works on “everything” (light duty vehicles thru 1 ton + class 4-8 vehicles), you’d check both 
boxes. This will open a secondary decision; ‘Start new orders by default using:’ This allows you to default to 
the models list you work on most. You can always toggle access to the other list during vehicle entry by 
changing this selector. 

 
 

User Setup Completed - Please continue to Final Steps for Launch. 
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• Final Steps: Better Prepared SE Launch 
Think You’re Ready Now? Consider This: 
The more you can enter in setup + real data, the better your LIVE startup experience will be. Entering this 
now will save time & effort down the road! 

 Best Customers with Vehicles  Your Technicians 
 Popular Parts into Inventory List  Your Vendors 
 Create Part Kits & Canned Jobs  Most Popular Notes 

By completing these tasks, your software will perform work faster, operate with minimal typing, provide 
expected results, and reflect your business. 

Note: Be sure you’ve been working in the LIVE program for all this input work. If it says Demo at the 
bottom of your screen, go to Home screen to access Configurations -> Special Maintenance, select 
Toggle Demo Mode. Answer Yes to return to ‘Live mode’ and restart as requested, the shop 
management program will reopen in the SE Live mode for your setup input. 

Anything you have input in Demo mode will need to be re-entered in the Live program mode. 

 

Double Check Your Settings 
For the same reason you wouldn’t let a customer take a vehicle without first taking it for a test drive, you 
need to be sure all of your settings are correct right BEFORE you start. A fast way to check many settings 
and defaults is to print a report. This helps you be certain program defaults work as expected. 

Printing the ‘Shop Data Setup’ Report 
1. Click Reports 

 
2. Double-click on Shop Data Setup to start report building process (5 seconds). 

 
3. If default Print to Screen is on, it will appear as screen preview. Report may be 

printed or also exported in various file formats. Click the Print Icon to print out 
a hard copy. 
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 Reviewing the Shop Data Report  
Since this report reflects your current settings, look it over very carefully. This data will appear on ALL 
paperwork, so it’s crucial this be correct before you begin. Below are some excerpts of the important 
information seen within this report. Please print and review to ensure your data and text appears as you 
expect 

 

. 

NOTE: If you identify any changes are needed, go to Shop Data Setup / Standard Tables to check 
settings and adjust them as needed. Then run report again. 
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 Final Countdown LIVE Checklist  
1. Shop Data Setup Complete 

 
2. Standard Tables Setup Complete 

 
3. Standard Descriptions Complete 

 
4. Catalog Configurations – You’ll want to make sure any parts catalogs are set up and 

integrated with the Management System before going LIVE. Visit How to Enable a Catalog 
and Link a Vendor in Manager (https://kb.mitchell1.com/articles/id-791/)  

Note: it is beyond the scope of this document to provide instruction on every supported parts catalog. 
Please read the setup procedure referenced above as well as the instructions that came with the 
catalog. 

5. Set Starting Invoice – see following page.  
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Set Starting Invoice 
This FINAL STEP is performed just before going 
live with SE. Enter#; future Invoice numbers 
advance sequentially from that number upward. 
For example, if you want to begin with Invoice 
#100, you’d enter starting invoice # 99 here. 

Important Note: Once you set the starting 
invoice #, you can’t go back and enter a lower 
number. 

 

 

 

 

Congratulations, you are ready to begin taking live orders and running your shop with your Mitchell 
1/ShopKey Shop Management Program! 
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